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Chapter 1 - Introduction

This guide takes you step-by-step through the process of installing Practice Partner on your server 
and workstations. Before you begin the installation, carefully read and understand all sections in 
this guide.

This guide references “Practice Partner,” a concept that implies that you are installing one of the 
following.

 • Patient Records and/or Appointment Scheduler with Medical Billing (Total Practice Partner)

 • Patient Records and Appointment Scheduler

 • Patient Records for Windows

 • Medical Billing for Windows

Because this guide covers the installation of all the products listed above, pay attention to the 
product-specific steps in this document. You need to complete only the steps that are applicable to 
the product you are installing. The product-specific steps or notes will be preceded with the product 
name in bold type; for example, Medical Billing Sites only.

Add-on modules
For step-by-step instructions for installing add-on modules, see the Practice Partner Add-ons 
Configuration and Installation Guide.

Product documentation
You can find the Practice Partner documentation referenced in this guide and the latest product 
documentation located at https://Supportcenter.emds.com/Richmond.

Comments welcome
We welcome your comments and suggestions on this guide. Feel free to contact eMDs.

Technical assistance
For technical assistance, contact Practice Partner Technical Support at https://
Supportcenter.emds.com/Richmond, or by calling the number appropriate to your type of 
organization. Follow the prompts and listen to all available choices as menu options may change.

 • Independent Support: 1-855-IND-TEAM (463-8326)

 • VAR Support: 1-855-VAR-TEAM (827-8326)

 • Enterprise Support: 1-855-ENT-TEAM (368-8326)

In this chapter
This chapter contains the following topics.

Topic See page

System Requirements 3

Limiting User Access to Practice Partner Programs 4

https://Supportcenter.emds.com/Richmond
https://Supportcenter.emds.com/Richmond
https://Supportcenter.emds.com/Richmond
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Chapter 1 - Introduction

Using Batch Files to Start and Stop Services 5

Notes for Electronic Medical Record (EMR) Sites Only 6

Order Entry 6

Prescription format files 6

Topic See page
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Chapter 1 - Introduction System Requirements

System Requirements

Running the Practice Partner system requires certain products in the following areas.

 • Server operating system

 • Client workstations

 • Third party software

For a complete list of system requirements, see the Practice Partner System Requirements Guide.
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Limiting User Access to Practice Partner Programs Chapter 1 - Introduction

Limiting User Access to Practice Partner 
Programs

Medical Billing for Windows, Patient Records, Appointment Scheduler, Order Entry, and Alpha II 
CodeWizard are all licensed separately. If you purchased a limited number of licenses, you can 
limit who has access to the applications to avoid running out of licenses. 

You can configure a user’s access to Practice Partner applications by selecting and clearing the 
appropriate access level items. For example, if you want the user to access only Medical Billing for 
Windows, select the Access cell for Hide AS except Provider Schedule, Hide PR?, and Hide 
Orders, and select Allow access to MB. The user will use only a Medical Billing user license.

On the General tab of the Access Level 
Configuration screen, when you...

Then a user assigned this access level 
will use a...

leave the following three items deselected 
for an access level

 • Hide AS except Provider Schedule?

 • Hide PR?

 • Hide Orders?

Patient Records user license, an 
Appointment Scheduler user license, and 
an Order Entry license.

select the Allow access to MB item for an 
access level

Medical Billing for Windows license.
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Chapter 1 - Introduction Using Batch Files to Start and Stop Services

Using Batch Files to Start and Stop Services

If your organization uses batch files to start and stop services (for example, PMSI Application 
Server), this could adversely affect your organization’s ability to send and receive claims with the 
Electronic Claims functionality, as claims are processed through services. eMDs recommends that 
you stop and start services manually.
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Notes for Electronic Medical Record (EMR) Sites Only Chapter 1 - Introduction

Notes for Electronic Medical Record (EMR) Sites 
Only

The following notes contain important information for sites installing Patient Records/Appointment 
Scheduler or Total Practice Partner.

Order Entry
Some Order Entry items (such as the Hide Orders? access item) may appear in Patient Records, 
even if you have not purchased Order Entry licenses. These items are not functional without a 
license.

Prescription format files
Practice Partner provides an example prescription format file in HTML format (Rx.cfg). This file is 
designed specifically for use with the Practice Partner HTML Editor. You can modify this file to suit 
your needs or use it as is. 

For more information, see the Printed Prescription Configuration Guide.

The example Rx.cfg file includes the following information.

 • Date.

 • Patient’s name and address.

 • First six allergies on the patient’s allergy list.

 • Details of the prescription (including up to six lines of the extended sig and the note).

 • Provider name.

 • Provider DEA, if the prescription is a controlled substance.

 • Practice name, address, phone number, and fax number.

 • Two areas for the provider to sign the printed prescription: one labeled ‘Substitution Permitted’ 
and one labeled ‘Dispense as Written’.

The example Rx.cfg file is located in the database directory (usually p:\ppart) and the \ppeditor 
directory (usually p:\ppart\ppeditor\).

Note: The Rx.cfg file applies only to printed and faxed prescriptions; it does not apply to 
transmitted prescriptions (sent using the Practice Partner ePrescribing module).
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Chapter 2 - Preparing for your Practice Partner Installation

Chapter 2 - Preparing for your Practice Partner 
Installation

This chapter provides instructions for the tasks you need to complete prior to installing your 
Practice Partner product(s), add-on products, interfaces, and licenses.

In this chapter
This chapter contains the following topics.

Topic See page

Preinstallation Tasks 8

Verify Minimum Requirements for your Server and Client 8

Install Microsoft Tools for Active Directory 8

Install and Configure your Database for Practice Partner 9

Back up your Servers 10

Download your Products from the Customer Support Website 10

Download your License Files 13
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Preinstallation Tasks Chapter 2 - Preparing for your Practice Partner Installation

Preinstallation Tasks

The preinstallation process includes the following tasks.

 • Verifying that your server and client specifications meet Practice Partner’s minimum 
requirements.

 • Installing Microsoft tools if you want to use Active Directory to install Practice Partner on client 
workstation(s).

 • Installing and configuring your database for Practice Partner on your server and client 
workstation(s).

 • Installing the proper Oracle Data Access Components (ODAC) - this is for Oracle sites only.

 • Backing up your server(s).

 • Downloading your software from the eMDs Practice Support website.

 • Downloading your license files from the eMDs Practice Support website.

Important: Make sure to review the Patch Release Notes documents for any necessary database 
changes. The Patch Release Notes documents are available on Salesforce.

Verify Minimum Requirements for your Server and Client 
Your server and client machine specifications must conform to Practice Partner’s minimum 
suggested requirements.

Each server and client machine must have enough free space to hold the installation. The 
application server must have at least 2 GB of free space available on the system partition. You can 
use the Practice Partner Custom Installation option to make sure that you have enough disk space 
available for the installation.

For more information, see the Practice Partner System Requirements Guide.

Install Microsoft Tools for Active Directory
If you want to use Active Directory to install Practice Partner on your client workstation(s), you must 
have the following Microsoft tools installed.

Tool Description

Microsoft Visual C++ redistributables The Microsoft Visual C++ Redistributable 
package must be installed on each client 
workstation. Visit the Microsoft Download 
website for more information.

Orca The Orca database editor is available in 
the Windows SDK Components for 
Windows Installer Developers. You can 
obtain Orca by downloading and installing 
the Windows Installer SDK. Visit the 
Microsoft Download website for more 
information.
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Chapter 2 - Preparing for your Practice Partner Installation Install and Configure your Database for Practice Partner

Install and Configure your Database for Practice Partner
Depending on what database server your site decides to use for Practice Partner, you must 
complete the following tasks before the installation. The information you enter here will be required 
to complete the installation.

Group Policy Management Console If you are a user who has the ability to edit 
Group Policy (you are a domain 
administrator or you have been given 
those rights by your domain administrator), 
you can install the Group Policy 
Management Console on the following 
operating systems.

 • Windows Vista Business Edition

 • Windows 7 Professional, Ultimate, or 
Enterprise Edition

 • Windows 8 Professional or Enterprise 
Edition

 • Windows Server 2008

 • Windows Server 2008 R2

 • Windows Server 2012

 • Windows Server 2016 Standard

NOTE: Windows 10 Home is not 
supported.

Visit the Microsoft Download website for 
more information.

Tool Description

Database What to run: To complete the 
installation, you 
need to know the...

For installation 
instructions, see:

SQL Server A script to create file 
groups.

hostname, instance 
name, user name, 
password, and target 
database name for 
your Practice Partner 
SQL Server instance.

“Creating a Microsoft 
SQL Server Database 
for Practice Partner” 
on page 45.

Oracle The Oracle 
tablespace script.

hostname, port 
number, username, 
password, and 
service name for your 
Practice Partner 
Oracle Server 
instance.

“Creating an Oracle 
Database for Practice 
Partner” on page 53.
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Back up your Servers Chapter 2 - Preparing for your Practice Partner Installation

If you are using c-tree Plus, no additional configuration is required.

Back up your Servers
Have a complete backup of each server before the installation.

Download your Products from the Customer Support Website
This section provides step-by-step instructions for downloading your products from the eMDs 
Practice Support website and extracting your installer files. Once you are logged into the eMDs 
Practice Support website, you can view your organization’s registered Practice Partner 11.0 
products on the Product Downloads and License Files page. To successfully install 11.0, you must 
download all of your products in the Registered Products list. To do this, repeat the steps below for 
each of the registered products in the list.

To download your software:
1. Go to the eMDs Practice Support website at https://practicesupport.emds.com.

2. Enter your eMDs Practice Support website user name and password, and then click the Login 
button.

If you do not have an eMDs Practice Support website account, contact the Project Manager or 
Install Engineer assigned to your organization to get details for your eMDs Practice Support 
website account.

3. Under Quick Links on the left side of the page, click the Downloads & License Files link.

Figure 1.  eMDs Practice Support website - Quick Links

c-tree Server The FairCom Server 
Activation utility.

You do not need to 
run this utility if you 
already have c-tree 
Server installed.

location of your c-tree 
Server binaries (for 
example the standard 
path for c-tree Server 
is 
C:\FAIRCOM\v7.12\c-
treeserver\c-
treeserver\).

“Installing and 
Administering a c-tree 
Server for Practice 
Partner” on page 61.

Database What to run: To complete the 
installation, you 
need to know the...

For installation 
instructions, see:

https://practicesupport.emds.com
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Chapter 2 - Preparing for your Practice Partner Installation Download your Products from the Customer Support Website

The Product Downloads and License Files page appears.

Figure 2.  Product Downloads and License Files page

4. To download the current version (11.0) of the application, click the Download Current Version 
button for that application.

To download the previous version (9.5.2) of the application, click the drop-down arrow on the 
Download Current Version button and select Download Previous Version from the menu.

See the tables in “Practice Partner Supplemental Functionality” for a complete list of product 
names and the product names as they appear on the website. 

Figure 3.  Product Downloads and License Files page

Note: If your version number is not 11.0, or a product that you have purchased is not in the list 
of registered products, call Practice Partner Technical Support as you will be unable to 
download the latest version.

The PRWIN, MBWIN, and ASWIN products are all the same software. You need to download 
only one of these from the eMDs Practice Support website. The appropriate options will be 
installed based on the contents of your license file. There is no content download specific to 
the Order Entry product. If your organization is licensed for Order Entry, it will be included as 
part of the Patient Records installation.

5. The File Download - Security Warning dialog box appears. Click the Save button.

6. Choose a download location on your hard disk and click Save. The download process begins. 
After the process is complete, the Download Complete dialog box appears.

7. Do one of the following:

 - Click the Run button.

or 

a. Click the Open Folder button to open the folder where the system saved the download.

b. Double-click the .exe file.
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Download your Products from the Customer Support Website Chapter 2 - Preparing for your Practice Partner Installation

8. The default extraction path is C:\eMDs\11.0. eMDs recommends that you do not change the 
default path. 

9. Click the OK button to start the extraction.

10. The files are extracted to the default location. If the files were extracted successfully, a 
confirmation message appears. Click the OK button.

11. Repeat the steps above to download all of your purchased products from the eMDs Practice 
Support website.
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Download your License Files
New license files are required for each new version of Practice Partner. You can download the 
product license files from the eMDs Practice Support website.

To download your license files:
1. Under Quick Links on the left side of the eMDs Practice Support website, click the 

Downloads & License Files link.

Figure 4.  eMDs Practice Support website - Quick Links

The Product Downloads and License Files page appears.

Figure 5.  Product Downloads and License Files page

2. To download the current (11.0) license file, click the drop-down arrow on the Download 
Current Version button and select Download License File from the menu.

To download the previous (9.5.2) license file, click the drop-down arrow on the Download 
Current Version button and select Download Previous License from the menu.

Figure 6.  Product Downloads and License Files page

The license file will be downloaded immediately to your machine.
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The installation procedures in this chapter are for new Practice Partner sites.

This chapter takes you step-by-step through the process of installing Practice Partner on your 
server and workstations.

Note: Do not rename or move the Practice Partner directory after the installation. This directory is 
used to register Practice Partner files and the program may fail to work if you change the directory 
name.

Features and requirements for the Practice Partner installation
The following table describes the features/requirements of the Practice Partner installation.

Feature/Requirement Is user interaction required?

If you do not have Crystal Reports v13 
installed, the Practice Partner installer will 
install it for you.

No.

If you do not have Microsoft .NET Framework 
4.0 or Microsoft Windows Installer 4.5 installed 
on the server and client, the Practice Partner 
installer will install these components for you.

In order to make the necessary updates, your 
server and client workstation(s) must have a 
valid Internet connection.

Not unless a reboot is required (typically from 
the Microsoft Windows installer patch).

Add download.microsoft.com to your trusted 
sites list, or disable Internet Explorer 
Enhanced Security Configuration (ESC) on 
your server.

Yes, see Internet Explorer online help for 
instructions and more information.

If you do not have a logical drive present on 
your machine, the Typical Installation option 
will not be available. You must select the 
Custom Installation option to complete the 
installation. You cannot install to a mapped 
drive; you must install on a physical fixed drive.

No.

Three services will be installed and started on 
the server: PMSI Application Server, PMSI 
Data Server, and PMSI Interoperability 
Service.

No.

If you are using a c-tree Server database, c-
tree Server will be migrated to a service as 
part of the installation. The PMSI Ctree Server 
service will be started on the Server after the 
installation. 

No.
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In this chapter
This chapter contains the following topics.

Microsoft Visual C++ Runtime 10.0 will be 
installed on the client and server.

No.

If you are using an Oracle database and are 
using any version of Windows Server 2012 or 
2016 for your application server, you must 
install .NET Framework 3.5 Features first and 
then the Oracle client. The Practice Partner 
install will NOT automatically install either and 
the Practice Partner install will fail if .NET 
Framework 3.5 Features is not installed first. 
Note that when installing the .NET Framework 
3.5 Features in Windows 2012 or 2016 server, 
you will need to specify an alternate source 
path to the Windows Server installation media.

Yes.

Feature/Requirement Is user interaction required?

Topic See page

Application Server Installation 17

Setting up Microsoft SQL Server 26

Setting up Oracle Server 28

Setting up c-tree Server 29

Client Workstation Installation 31

Using Active Directory® to Install Practice Partner on Client 
Workstations

37

Creating a Shared Network Drive 37

Creating a Transform for the Practice Partner Client Workstation 
Installer

38

Adding or Editing Group Policy Settings to Deploy the Client 
Installer

39

Restarting Client Workstations to Complete the Practice Partner 
Client Installation

40

Post-Installation Tasks 41

Upgrading to Practice Partner Release 11.2 44
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Application Server Installation

If you are using Windows Terminal Services (WTS) or Citrix, use the change user command at a 
command prompt to switch your Terminal Services server to Install mode.

1. Click Start > Run.

2. In the Open box, enter cmd and click OK.

3. At the command prompt, enter change user /install and press Enter. The following message 
appears: ‘User session is ready to install applications’.

4. Enter exit and press Enter.

5. Add or remove the programs that you want.

To install the application server:
1. Log on as the local administrator on your server.

2. Refer to the following table.

If you do not have Microsoft .NET Framework 4.0 installed, NET 4.0 installs automatically on 
the server. After .NET is installed, it will determine if a reboot is required. If a reboot is required, 
a dialog box displays giving you the choice to reboot now or later. You must reboot before 
continuing with the installation. After the reboot is complete, if the installation does not restart 
automatically, you should restart the installation.

Do you have a CD? Then...

Yes insert the Practice Partner - Server CD into the CD-ROM drive on 
your server. If the CD does not start automatically, complete the 
following steps.

1. Select Run from the Start button on the taskbar.

2. Enter d:\setup.exe, where d is the location of (or complete 
path to) the CD-ROM drive.

3. Click OK.

No browse to the folder where you saved the Practice Partner Server 
setup.exe file when you downloaded it from the eMDs Practice 
Support website and copy the setup.exe file to your server.

Double-click setup.exe.
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The Welcome screen appears.

Figure 7.  Welcome screen

4. Click Install Practice Partner Server to proceed with the Practice Partner installation. The 
End-User License Agreement screen appears.

Figure 8.  End-User License Agreement screen
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5. Read the license agreement, select the I accept the terms in the License Agreement check 
box, and click Next. (If you want to print the license agreement, click Print before you click 
Next.) The Practice Partner License screen appears.

Figure 9.  Practice Partner License screen

6. Select the location of the license file.

a. The default location for the license file is the C: drive. If you are using a license file 
located at any other location, you can navigate to the license file’s location.

b. After you select the license file folder, click Next.

Note: New license files are required for each new version of Practice Partner. If you have not 
downloaded your license files, exit the installation and download the license files from the 
eMDs Practice Support website. For complete download instructions, see “Download your 
License Files” on page 13.
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The Initial posting date screen appears.

Figure 10.  Initial posting date screen

7. For Medical Billing and Total Practice Partner sites only: Enter the month, day, and year (mm/
dd/yyyy format) of the initial posting date in the provided field.

8. Enter a username and password to create a new user account. This account will have 
complete access to Practice Partner, including the ability to set and change password 
protection for other users of the program. Practice Partner provides several levels of password 
protection; the default system level is ‘HI’. Complete the fields as indicated in the following 
table.

Field Description

Username Enter a username.

Password Enter a password.

For security reasons, your password 
must be a minimum of eight characters 
long and consist of a combination of 
letters and at least one number and one 
non-alphanumeric character. Your 
password cannot be the same as your 
username.

Verify Password Enter the password you entered in the 
Password field.
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9. Click Next. The Clearinghouse activation screen appears.

Figure 11.  Clearinghouse activation screen

10. Select No and click the Next button. The Choose Setup Type screen appears.

Figure 12.  Choose Setup Type screen
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11. Use the following table to determine which button to click.

Typical Installation
12. Click Typical. The Ready to Install Practice Partner Server screen appears.

13. Click Install to begin the installation. The Installing Practice Partner screen displays the status 
of the installation.

If you chose to activate your system to the Practice Partner Clearinghouse, a confirmation 
message appears if the activation is successful. If the activation fails, an error message 
appears explaining what caused the error. To retry the activation, click Retry Activation. If you 
want to activate later, click Activate Later. You can activate your system later by double-
clicking pmsi.ch.activation.exe located in the \ppart directory.

14. When the installation is complete, click Finish.

The installation placed required registry keys in the registry of your application/file server. 
Reboot your server before production use of the Practice Partner application to ensure that 
these settings are enabled.

15. Install the client components. See “Client Workstation Installation” on page 31.

16. If you want to use the auto-generate demographic IDs feature, see “Auto-Generate 
Demographic IDs” on page 69.

Button Description

Typical Installs the most common program 
features. Click this button only if you are 
using a c-tree Server database. If you 
are using an Oracle, Microsoft SQL 
Server, or c-tree Plus database, you 
must click Custom to complete the 
installation.

If you do not have a logical drive present 
on your machine, this button is not 
available. You must click Custom to 
complete the installation.

If you click this button, continue with step 
14 in “Typical Installation” on page 22.

Custom Allows you to choose which program 
features to install and where they will be 
installed. You must click this button if you 
are using an Oracle, Microsoft SQL 
Server, or c-tree Plus database. 

If you click this button, continue with step 
14 in “Custom Installation” on page 23.
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Custom Installation
14. Click Custom. The Custom Setup screen appears.

Figure 13.  Custom Setup screen

15. The following table describes how the options on this screen allow you to set your preferences 
for the way features will be installed on your computer.

Click... To...

the plus signs (+) in the tree 
structure

view all available features for which you can set 
preferences.

a feature icon open a menu with the installation options that you 
can select for the feature. Click a menu item on 
the list to select it.

a feature see the amount of disk space that is required to 
install the feature and its sub-features on your 
computer.

the Disk Usage button make sure that you have enough disk space 
available on the selected disk drive.

This button opens the Disk Space Requirements 
screen that lists

 • all disk drives (volumes) you have on your 
computer.

 • the total disk size for each disk volume.

 • the available space.

 • the required space.

 • the disk space that will remain available after 
you install the respective feature.
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16. Click Next. The Select Database Type screen appears.

Figure 14.  Select Database Type screen

17. Select the database type that you are using and click Next. The following table lists the screen 
that appears depending on what database type you selected.

the Browse button select a different destination folder for the 
installation.

the Reset button clear all of your selections, if needed.

If you selected... Then this screen appears...

Microsoft SQL Server MSSQL Instance Info.

See “Setting up Microsoft SQL Server” 
on page 26 to complete the installation.

Oracle Server Oracle Instance Info.

See “Setting up Oracle Server” on page 
28 to complete the installation.

Click... To...
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c-tree Plus Ready to install Practice Partner Server.

1. Click Install to begin the 
installation. The Installing Practice 
Partner screen displays the status 
of the installation.

If you chose to activate your system 
to the Practice Partner 
Clearinghouse, a confirmation 
message appears if the activation is 
successful. If the activation fails, an 
error message appears explaining 
what caused the error. To retry the 
activation, click Retry Activation. If 
you want to activate later, click 
Activate Later. You can activate 
your system later by double-clicking 
pmsi.ch.activation.exe located in 
the \ppart directory.

2. When the installation is complete, 
click Finish. The installation placed 
required registry keys in the registry 
of your application/file server. 
Reboot your server before 
production use of the Practice 
Partner application to ensure that 
these settings are enabled.

3. Install the client components. See 
“Client Workstation Installation” on 
page 31.

c-tree Server c-tree Server Information.

See “Setting up c-tree Server” on page 
29 to complete the installation.

If you selected... Then this screen appears...
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Setting up Microsoft SQL Server
If you selected the Microsoft SQL Server option on the Select Database Type screen, the MSSQL 
Instance Info screen appears. Use this screen to enter the information needed for a connection to 
a Microsoft SQL instance.

Figure 15.  MSSQL Instance Info screen

Before the installation, you must create a SQL Server Practice Partner database and run a script to 
create file groups. See the “Creating a Microsoft SQL Server Database for Practice Partner” on 
page 45 for step-by-step instructions.

The Practice Partner installation will create a Microsoft SQL Server username and password (for 
example, pp_dbname_app and pp_dbname_upd, where dbname is the name of the Microsoft 
SQL Server database). Once the installation creates the username and password, do not delete or 
change them in the database.

To set up your MSSQL Server:
1. Refer to the following table to complete the fields on the MSSQL Instance Info screen.

Field Value

Host Enter the hostname of the database 
server (the name of the host instance of 
SQL Server).

Instance Enter the SQL Server instance name 
(the name of the server on the host) that 
you want to use with Practice Partner.
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2. Click Next. The Ready to install Practice Partner Server screen appears.

3. Click Install to begin the installation. The Installing Practice Partner screen displays the status 
of the installation.

If you chose to activate your system to the Practice Partner Clearinghouse, a confirmation 
message appears if the activation is successful. If the activation fails, an error message 
appears explaining what caused the error. To retry the activation, click Retry Activation. If you 
want to activate later, click Activate Later. You can activate your system later by double-
clicking pmsi.ch.activation.exe located in the \ppart directory.

4. When the installation is complete, click Finish.

The installation places required registry keys in the registry of your application/file server. 
Reboot your server before production use of the Practice Partner application to ensure that 
these settings are enabled.

Username Enter PPINSTALL. This is the SQL 
Server username created for your SQL 
Server instance. The username allows 
the installer to log onto SQL Server.

The user must be a member of the 
securityadmin fixed server role and have 
privileges to create users and roles.

Password Enter the SQL Server user account 
password. This is the password created 
for your SQL Server instance. The 
password allows the Practice Partner 
installer to log onto SQL Server.

Target DB Enter the name of the target database. 
This is the name you entered when you 
created the database, and will be the 
database on which Practice Partner will 
be created.

Field Value
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Setting up Oracle Server
If you selected the Oracle Server option on the Select Database Type screen, the Oracle Instance 
Info screen appears. Use this screen to enter the information needed for a connection to an Oracle 
instance.

Figure 16.  Oracle Instance Info screen

Before the installation, you must create an Oracle Server Practice Partner database and run a 
script to create the proper tablespaces. See the “Creating an Oracle Database for Practice Partner” 
on page 53 for step-by-step instructions.

The Practice Partner installation will create an Oracle username and password (for example, 
pp_dbname_app and pp_dbname_upd, where dbname is the name of the Oracle database). 
Once the installation creates the username and password, do not delete or change them in the 
database.

To set up your Oracle Server:
1. Refer to the following table to complete the fields on the Oracle Instance Info screen.

Field Value

Host Enter the hostname of the database 
server. This field defaults to the name of 
the machine on which the installation in 
running.

Port Enter the network port number.

Username Enter the username for the Oracle 
instance. This is the username created 
when the database was created. The 
name must be sys.

Password Enter the user password for the Oracle 
instance.
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2. Click Next. The Ready to install Practice Partner screen appears.

3. Click Install. The installation begins and the Installing Practice Partner screen displays the 
status of the installation.

If you chose to activate your system to the Practice Partner Clearinghouse, a confirmation 
message appears if the activation is successful. If the activation fails, an error message 
appears explaining what caused the error. To retry the activation, click Retry Activation. If you 
want to activate later, click Activate Later. You can activate your system later by double-
clicking pmsi.ch.activation.exe located in the \ppart directory.

4. When the installation is complete, click Finish.

The installation places required registry keys in the registry of your application/file server. 
Reboot your server before production use of the Practice Partner application to ensure that 
these settings are enabled.

Setting up c-tree Server
If you selected the c-tree Server option on the Select Database Type screen, the c-tree Server 
information screen appears. Use this screen to enter the information needed for a connection to 
your c-tree Server database.

Figure 17.  c-tree Server information screen

Service Name Enter the Oracle instance name (the 
name of the server on the host). This is 
the name of the Oracle instance that 
your site wants to use with Practice 
Partner.

Field Value
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Before the installation, you must install c-tree Server and configure c-tree Server and clients for 
use with Practice Partner. You can skip this step if you already have c-tree Server installed. See 
“Installing and Administering a c-tree Server for Practice Partner” on page 61 for more information.

Important: You must run the FairCom Server Activation utility prior to the Practice Partner 
installation. See the “Running the FairCom Server Activation Utility” on page 64 for more 
information.

To set up c-tree Server:
1. In the Location field, enter or browse to the path to the c-tree Server binaries on your machine 

(for example, the standard path for c-tree Server is C:\FAIRCOM\v7.12\c-treeserver\c-
treeserver\).

2. Click Next. The Ready to install Practice Partner Server screen appears.

3. Click Install. The installation begins and the Installing Practice Partner screen displays the 
status of the installation.

If you chose to activate your system to the Practice Partner Clearinghouse, a confirmation 
message appears if the activation is successful. If the activation fails, an error message 
appears explaining what caused the error. To retry the activation, click Retry Activation. If you 
want to activate later, click Activate Later. You can activate your system later by double-
clicking pmsi.ch.activation.exe located in the \ppart directory.

4. When the installation is complete. click Finish.

The installation places required registry keys in the registry of your application/file server. 
Reboot your server before production use of the Practice Partner application to ensure that 
these settings are enabled.
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Client Workstation Installation

Complete Practice Partner client workstation installations directly on the client machines on which 
you want to install Practice Partner. You cannot install Practice Partner on the client workstations 
from the Server. If your site has access to Active Directory, you can use Active Directory to install 
Practice Partner on your client workstations. See “Using Active Directory® to Install Practice 
Partner on Client Workstations” on page 37 for step-by-step instructions.

Set up and customize Practice Partner before you install Practice Partner on the client 
workstations.

The client workstations must be running Windows Vista Business Edition; Windows 7 Professional, 
Ultimate, or Enterprise Edition; or Windows 8 Professional or Enterprise Edition.

To install the Oracle client, see “Install the Oracle Client” on page 58.

To install Practice Partner on a client workstation:
1. Log on to the client workstation as a user with administrative privileges.

2. Browse to the folder where you saved the Practice Partner Client setup.exe file. The 
executable file is downloaded from the eMDs Practice Support website, and the default 
locations to which the file is extracted are:

 - C:\McKesson\11.0\ASWIN\Practice Partner Client (Appointment Scheduler)

 - C:\McKesson\11.0\MBWIN\Practice Partner Client (Medical Billing)

 - C:\McKesson\11.0\PRWIN\Practice Partner Client (Patient Records)

3. Copy the Practice Partner Client setup.exe file to the client workstation.

4. Double-click setup.exe.

If you have a Practice Partner - Client CD, insert it in the CD-ROM drive and complete the 
following steps.

a. On the Windows Start menu, click Run.

b. Enter d:\setup.exe, where d is the location of (or complete path to) the CD-ROM drive.

c. Click OK.

Note: Do not use the Run as administrator option to start the installation.
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5. Refer to the following table.

If you do not have this installed... Then...

Crystal Reports v13 the Practice Partner Client Setup screen 
appears. 

Figure 18.  Practice Partner Client Setup 
screen

Click Accept to automatically install 
Crystal Reports v13 on your system and to 
continue with the Practice Partner 
installation.

Microsoft .NET Framework 4.0 NET 4.0 installs automatically on the 
client. After .NET is installed, it will 
determine if a reboot is required. If a 
reboot is required, a dialog box displays 
giving you the choice to reboot now or 
later. You must reboot before continuing 
with the installation. Once the reboot is 
complete, if the installation does not restart 
automatically, you should restart the 
installation.
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The Welcome to the Practice Partner Client Setup Wizard screen appears.

Figure 19.  Practice Partner Client Setup Wizard screen

6. Click Next. The End-User License Agreement screen appears.

Figure 20.  End-User License Agreement screen
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7. Read the license agreement, select the I accept the terms in the License Agreement check 
box, and click Next. The Choose Setup Type screen appears.

Figure 21.  Choose Setup Type screen

8. Refer to the following table to determine the appropriate installation option.

Button Description

Typical Click this button to install the most 
common program features.

The client will be installed in 
C:\Program Files\eMDs\Practice 
Partner for 32-bit operating systems 
and in C:\Program 
Files(x86)\eMDs\Practice Partner for 
64-bit operating systems.

Skip to step 12 to complete the 
installation.

Custom Click this button to choose which 
program features to install and where 
they will be installed. eMDs 
recommends that only advanced users 
select this option.

Continue with step 9 to complete the 
installation.
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9. The Custom Setup screen appears.

Figure 22.  Custom Setup screen

The following table describes the items on this screen that you can use to set your preferences 
for the installation.

Item Description

Plus signs in the tree structure Click these to view all available features 
for which you can set preferences.

Feature icon Click these to open a menu with the 
installation options that you can select 
for the feature. Click a menu item on the 
list to select it.
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Feature Click a feature to view the amount of 
disk space required to install the feature 
and its sub-features on your computer.

Click the Disk Usage button to make 
sure that you have enough disk space 
available on the selected disk drive. The 
Disk Usage button accesses the Disk 
Space Requirements screen, which lists

 • all disk drives (volumes) you have 
on your computer.

 • the total disk size for each disk 
volume.

 • available space.

 • required space.

 • disk space that will remain available 
after you install the feature.

Browse button Click this button to select a different 
destination folder for the Practice 
Partner client, and then click OK. 

The default location is C:\Program 
Files\eMDs\Practice Partner for 32-bit 
operating systems and C:\Program 
Files(x86)\eMDs\Practice Partner for 
64-bit operating systems.

Reset button Click this button to clear all of your 
selections, if needed.

Item Description
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10. Click Next. The Practice Partner Server Location Info screen appears.

Figure 23.  Practice Partner Server Location Info screen

11. Select the directory where the Practice Partner server is located (this is the directory you 
selected during the Practice Partner server installation). Click Next.

12. Click Install. The installation begins and the Installing Practice Partner Client screen displays 
the status of the installation.

13. When the installation is complete, click Finish.

14. Repeat this procedure for each client workstation on which you want to install Practice Partner.

Using Active Directory® to Install Practice Partner on Client 
Workstations

Installing Practice Partner on client workstations using Active Directory includes the following 
procedures.

1. Creating a shared drive

2. Creating a transform using Orca

3. Creating or editing an existing group policy

4. Restarting the client workstations

Creating a Shared Network Drive
Create a shared network drive with full access to the workstations on which you want to install the 
Practice Partner client. This drive also can be the shared drive on which you installed Practice 
Partner. If you choose to use an existing shared drive, you can skip this procedure as long as you 
give full access to the workstations on which you want to install the client.
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Note: You must have administrative rights to create a shared directory.

To create a shared network drive:
1. Open My Computer.

2. Navigate to the drive you want to share.

3. Right-click on the hard drive icon and click Sharing and Security.

4. Select the Share this folder option. In the Share name field, enter a name by which you want 
to share this folder.

5. Click Permission and select the users on which you want to install the client.

6. Click OK. The Properties screen appears.

7. Click Apply.

8. On the shared drive, create a folder named Software.

 - To create a folder, right-click My Computer and select New > Folder.

9. Save the Practice Partner Client Installer (Practice Partner Client.exe) in the Software folder.

Creating a Transform for the Practice Partner Client Workstation Installer
Create a transform for the Practice Partner Client Workstation Installer and save it on the shared 
drive.

To create a transform for the Practice Partner Client Workstation Installer:
1. Open Orca.

2. In Orca, select File > Open. Browse to where Practice Partner Client.exe is saved in the 
Software folder on the shared drive.

3. Select Transform > New Transform.

4. In the left pane, click LaunchCondition.

5. Right-click Installed OR VC8INSTALLED OR VersionNT < 600 and select Drop Row. A 
confirmation message displays.

6. Click OK to continue.

7. In the left pane, click Property.

8. Select the Value cell for NETWORKINSTALL and press Enter.

9. Change the value from 0 to 1.

10. Upgrade only Select the Value cell for EXISTINGPRWIN and press Enter.

11. Change the value to the path of the existing 9.4.x client. For example, c:\prwin.

12. Upgrade only Select the Value cell for LEGACYCLIENTUPGRADE and press Enter.

13. Change the value to 1.

14. Right-click anywhere in the property view (right pane) and select Add Row. The Add Row 
screen appears.
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15. Click Property and enter PPARTNETDIR in the Property field.

16. Click Value and enter the UNC path for the \ppart directory on the server. For example, 
\\dvtestdc\p\ppart\. When you are finished, click OK.

17. Select the Value cell for PPARTMAPDIR and press Enter. Change the value to what the client 
will map to the server as. For example: P:\ppart\. When you are finished, click OK.

18. Select Transform > Generate Transform. The Save Transform As screen appears.

19. In the File name field, enter the desired name of the file (for example, Client network install) 
and save the transform on the shared drive.

Adding or Editing Group Policy Settings to Deploy the Client Installer
Add or edit an existing group policy using the Group Policy Management Console to add the 
installation package to your settings and deploy the package to your client workstations.

To add or edit a group policy to deploy the client installer:
1. Open the Group Policy Management Console.

2. Complete one of the following procedures.

3. In the console tree, double-click Computer Configuration > Policies > Software Settings > 
Software installation.

4. In the console tree, right-click Software installation and select New > Package.

5. In the Open dialog box, click Practice Partner Clients, and then click Open.

6. In the Deploy Software dialog box, click Advanced, and then click OK.

If you are upgrading Practice Partner Zoom, the IQmarkTM Digital ECG Module, or the 
IQmarkTM Digital Spirometer Module on your client workstations, click Assigned and then click 
OK. You then can restart your client workstations to upgrade to the latest version of Zoom.

7. In the Properties dialog box, click the Modifications tab.

8. Click Add. In the Open dialog box, browse to the transform file (.mst) you created in “Creating 
a Transform for the Practice Partner Client Workstation Installer” on page 38 and then click 
Open.

9. When you are finished, click OK and then close the Group Policy Management Editor.

To... Then complete these steps...

add a group policy 1. Right-click on the Practice Partner 
folder and select Create a GPO in 
this domain, and link it here. The 
New GPO screen appears.

2. Enter the name of the new GPO (for 
example, PP Software) and select 
a source starter GPO from the drop-
down menu. Click OK.

edit an existing group policy  • In the left pane, right-click the policy 
name and select Edit.
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Restarting Client Workstations to Complete the Practice Partner Client 
Installation

After you complete the steps in the previous sections, Active Directory requires you to restart your 
client workstations to upgrade to the latest version of Practice Partner. After you restart the 
workstations, users can log in to Practice Partner. The deployments of the installer as outlined in 
the previous steps may take a considerable amount of time. You may want to wait a while before 
restarting your client workstations.
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Post-Installation Tasks

The following table lists general tasks to complete after installing Practice Partner.

Important: Make sure to review the Patch Release Notes documents for any necessary database 
changes. The Patch Release Notes documents are available on Salesforce.

Task Description

Launch the application and log in Confirm that the installation was properly 
completed and that the system is 
operational by launching the application 
and logging in.

Read the Practice Partner online help for 
information on configuring Practice Partner

For information on configuration Practice 
Partner for your practice, see the 
configuration topics in the Medical Billing, 
Patient Records, and Appointment 
Scheduler online help. You can access 
Practice Partner Help from any of the 
applications by clicking the Help button or 
by pressing F1 from any of the Practice 
Partner screens.

Some of the options you can set up 
include:

 • Access levels

 • Operators

 • Demographic settings

 • Demographic guides

 • Ledger templates

 • Address defaults

 • Printers and printer fonts

Read the Release Notes Refer to the Release Notes for descriptions 
of the new features.
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Modify additional patient information types Practice Partner is configured with four 
patient information types:

 • Alias

 • 1st Type

 • 2nd Type

 • 3rd Type

These types are placeholders, and you 
should modify them to meet your needs. 
The [Demographics] section of the 
ppart.ini file contains the following line:

AddInfoType=Alias,1st 
Type,2nd Type,3rd Type

You can change these type or add 
additional types. For example, you might 
have:

AddInfoType=Alias,Summer 
Home,Winter 
Home,Grandmother’s Home

Be careful about changing or deleting the 
types once you start using Practice 
Partner. Once data has been entered for a 
type, the data can be retrieved only if that 
type still exists in the ppart.ini file.

Task Description



Installation Guide
March 2019 Release 11.2 43

Chapter 3 - Installing Practice Partner Post-Installation Tasks

Update the properties for your network 
card (NIC)

In the properties of your network adapter, 
clear the Internet Protocol Version 6 
check box; otherwise, you may experience 
slowness in your application. 

Install patches Complete the following steps to avoid 
having to install all pre-2017 patches.

1. Install ALL 2017 patches in order, 
making sure to OMIT the 04/05/2017 
Client/Server patches until there are 
no more 2017 patches left. 

NOTE: All of the pre-2017 patches will 
be in the list. Do not be alarmed - this 
is normal.

2. Once there are only the 04/05/2017 
patches left, install both Client/Server 
patches, leaving all the pre-2017 
patches uninstalled.

3. Once the Update Manager reboots 
after installing patches, all of the post-
04/05/2017 patches will be available 
as you now are pointing to another 
bucket. You then can install all the 
remaining patches in order through 
the current patch.

If you have questions, contact Practice 
Partner Support.

Task Description
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Upgrading to Practice Partner Release 11.2

Once you have Practice Partner Release 11.0 installed, you must upgrade to release 11.1, then to 
release 11.2.

Complete the following steps.

Install patches to upgrade to 11.1
1. Install ALL of the 2017 patches in order, starting with the 2/2017 cumulative patch, making 

sure to OMIT the 4/5/2017 client/server patches until there are no more patches left.

NOTE: All of the other pre-2017 patches will be on the list. Do not be alarmed; this is normal.

2. When there are only the 4/5/2017 patches left, install both client/server patches, leaving all the 
pre-2017 patches uninstalled.

3. Once the Update Manager reboots after installing patches, all of the post-4/5/2017 patches will 
be available, as you now are pointing to another bucket. You then can install all the remaining 
patches through current.

NOTE: eMDs recommends that you install the server patches first in order one-by-one post-4/
5/2017 patch so that you can verify that the database changes are made without error. The 
error will be noticeable in the command prompt window but also is recorded in the 
ppart\ligs\MaintenanceEngine.log text file. If you have an error, contact Technical Support.

4. Once the server has updated, you can accept all other patches together by selecting all.

NOTE: Be aware that there are release notes for all patches after GA release; this database 
change must be done on all NEW installs. Refer to the Practice Partner Resolved Issues - 3rd 
Quarter 2015 document for these instructions. If you are an Oracle or SQL user, refer to the 
SocialKB article titled ‘TFS 167576 SetHealthMaintDataUID for SQL or Oracle’ to obtain scripts to 
resolve this.

If you have questions, please contact Technical Support.

Upgrade to 11.2
Upgrade to Practice Partner Release 11.2 by following the instructions in Practice Partner Upgrade 
and Configuration Guide for Release 11.2.

This upgrade guide is available on the eMDs Practice Support website.
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Appendix A - Creating a Microsoft SQL Server 
Database for Practice Partner

The following table indicates whether this appendix applies to your situation.

This appendix provides step-by-step instructions for creating a new Microsoft® SQL Server® 
database for Practice Partner.

You must create a new database before installing Practice Partner. 

Technical assistance
If you need technical assistance or have questions regarding these instructions, contact Practice 
Partner Technical Support at https://practicesupport.emds.com or by calling the number 
appropriate to your type of organization. Follow the prompts and listen to all available choices as 
menu options may change.

 • Independent Support: 1-855-IND-TEAM (463-8326)

 • VAR Support: 1-855-VAR-TEAM (827-8326)

 • Enterprise Support: 1-855-ENT-TEAM (368-8326)

What database are you using? Appendix to use to create your 
database:

Microsoft SQL Server This appendix.

Oracle “Creating an Oracle Database for Practice 
Partner” on page 53.

c-tree “Installing and Administering a c-tree 
Server for Practice Partner” on page 61.

https://practicesupport.emds.com
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Installing Microsoft SQL Server Software

You must install Microsoft SQL Server software on your database server before creating a 
database for Practice Partner.

Before installing the software, complete a full system backup of your current production 
environment. The backup must include everything needed to recreate your production 
environment. Do not proceed to the following steps until your backup is complete and verified.

When you install SQL Server, you can use the default installation options in most circumstances, 
with the following exceptions.

 • For database components, select the Database Engine services and the Management 
Tools.

 • Select Mixed Mode Authentication for the Authentication Method. 

See your Microsoft SQL Server documentation for SQL Server installation instructions.
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Creating the Database Directory Structure

To create the Practice Partner database, you must build an initial directory structure to house the 
data files and log files. The example below depicts a standard single drive installation of the 
database and the necessary file structure.

eMDs’ recommended SQL Server configuration is to place data files and log filed on different 
logical drives (arrays, LUNs, or disks). For example, F:\PROD\DATA and G:\PROD\LOG. The 
following steps follow this recommendation.

To create the database directory structure:
1. Open Windows Explorer and navigate to the drive where your database is located (for 

example, F:\).

2. Create a PROD folder on the database drive.

a. Create a new folder by right-clicking a blank area in a folder window or on the desktop, 
pointing to New, and clicking Folder.

b. Rename the default folder to PROD and press Enter.

3. Create a DATA folder in the PROD folder.

4. Navigate to your log drive (for example, G:\).

5. Create a PROD folder on the log drive.

a. Create a new folder by right-clicking a blank area in a folder window or on the desktop, 
pointing to New, and clicking Folder.

b. Rename the default folder to PROD and press Enter.

6. Create a LOG folder in the PROD folder.
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7. Close Windows Explorer.
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Creating the Empty Database

Complete the following steps to create an empty database.

To create a new database:
1. Log on to the server as an administrator.

2. Select Start > Programs > Microsoft SQL Server > Microsoft SQL Server Management 
Studio. The Connect to Server screen appears.

Figure 24.  Connect to Server screen

3. In the Server name field, enter or select the server name. Click Connect. The Microsoft SQL 
Server Management Studio screen appears.

Figure 25.  Microsoft SQL Server Management Studio screen
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4. In the Object Explorer area on the left side of the window, expand the Databases folder.

5. Right-click the Databases folder and select New Database. The New Database screen 
appears.

Figure 26.  New Database screen

6. In the Database name field, enter the preferred name of your SQL database. As a general 
rule, PROD is the default name for the Production copy of the database.

7. In the Database files section, scroll to the right until you reach the Path heading. Change the 
path of the related database files as shown below based on the directory structure of the 
system.

eMDs recommends that you place the DATA folder and the LOG folder on different disks. For 
example, F:\PROD\DATA and G:\PROD\LOG.

Figure 27.  New Database screen

8. Click OK and wait for the database creation process to complete.

When the process is complete, the database name is listed under the Object Explorer 
database section on the Microsoft SQL Server Management Studio screen.
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Creating the Practice Partner File Groups

After you create the database, you must create the Practice Partner file groups. This requires 
running the SQL110 script file located in the Oracle SQL folder on the Practice Partner - Server CD.

To run the SQL110.sql script:
1. Highlight the database name and select File > Open > File. The Open File screen appears.

Figure 28.  Open File screen

2. Navigate to the Oracle SQL folder on the Practice Partner - Server CD, select the SQL110.sql 
script, and click Open. The initial creation script for the Practice Partner database loads.

3. Replace <password> with the password you want to use for your SQL Server instance. This is 
the password you will enter during the Practice Partner Application Server installation. The 
username you will enter during the installation is PPINSTALL. See “Setting up Microsoft SQL 
Server” on page 26 for more information.

4. Replace *DRIVE* with the appropriate drive letter for the database files and replace 
*DBNAME* with the appropriate name of the database that you created in step 6 in “Creating 
the Empty Database” on page 49.

a. Select Edit > Find and Replace > Quick Replace. The Find and Replace screen appears.

b. Enter *DBNAME* or *DRIVE* in the Find what field and enter the name of the database 
or drive letter in the Replace with field. Use the Find Next, Replace, and Replace All 
buttons to find and replace the database name and drive.

5. Click Execute and wait for the script to complete.

6. You now can install Practice Partner. Continue with “Back up your Servers” on page 10.
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Appendix B - Creating an Oracle Database for 
Practice Partner

The following table indicates whether this appendix applies to your situation.

This appendix provides step-by-step instructions for creating a new Oracle® database for Practice 
Partner.

You must create a new database and install and configure the Oracle client on your workstations 
before installing Practice Partner.

Technical assistance
If you need technical assistance or have questions regarding these instructions, contact Practice 
Partner Technical Support at https://practicesupport.emds.com or by calling the number 
appropriate to your type of organization. Follow the prompts and listen to all available choices as 
menu options may change.

 • Independent Support: 1-855-IND-TEAM (463-8326)

 • VAR Support: 1-855-VAR-TEAM (827-8326)

 • Enterprise Support: 1-855-ENT-TEAM (368-8326)

What database are you using? Appendix to use to create your 
database:

Microsoft SQL Server “Creating a Microsoft SQL Server 
Database for Practice Partner” on page 45

Oracle This appendix.

c-tree “Installing and Administering a c-tree 
Server for Practice Partner” on page 61.

https://practicesupport.emds.com
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Creating a New Database

Before you create a new Oracle database, complete a full cold backup of your Oracle database 
server. This backup must include everything you need to re-create your production environment. 
Do not continue until the backup is complete and verified.

To create a new Oracle database:
1. Install the Oracle 11g Release 2 software on your server. eMDs recommends Oracle 11g 

version 11.2.0.4 or later.

2. Create an Oracle database using the Oracle 11g Database Configuration Assistant tool. See 
your Oracle documentation for more information on creating an Oracle database.

When you create the database, configure the following:

On this screen... Do this...

Step 1 - Database Operations Select the Create a Database option.
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Step 8 - Recovery Configuration Change the default value for Flash 
Recovery Area Size to 51200 M Bytes 
(or larger if possible; see bulleted items 
below for best sizing).

eMDs recommends that you select a 
value for the flash recovery area that is 
large enough to hold a copy of all of your 
control files, online redo logs, the 
archived redo log files, and possible 
backup files needed to recover your 
database.

 • The larger the flash recovery area, 
the more useful it becomes; 
however, eMDs recommends not 
selecting a value larger than your 
disk partition size or ASM disk 
group size.

 • Setting the flash recovery area limit 
smaller than your disk partition size 
or disk group size allows you to use 
the remaining disk space for other 
purposes and not to dedicate a 
complete disk for the flash recovery 
area.

 • If possible, use the Browse button 
to select a dedicated file system 
partition or an ASM disk group to 
place the flash recovery area. The 
optimum recovery area size 
depends on the interval time 
between two processes (scheduled 
by the site) that purge both backed-
up archive log files and obsolete 
backup files according to 
redundancy policy.

Step 8 - Recovery Configuration Select the Enable Archiving check box.

On this screen... Do this...
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4. Log into the Oracle database you just created as a system user and run the Oracle tablespace 
script (located in the Oracle SQL folder on the Practice Partner - Server CD) to create 
tablespace.

To run the Oracle tablespace script:

a. With a text editor such as Notepad, open the ORACLE110.sql file located in the Oracle 
SQL folder on the Practice Partner - Server CD. 

b. Replace *DRIVE* with the appropriate drive letter for the database files. eMDs 
recommends that you use your database name in the file path (for example, e:\database 
name).

If your Oracle database uses Automatic Storage Management (ASM), replace *DRIVE* 
with the ASM disk group name (for example, +DISKGROUP).

To find and replace the drive:

a.Select Edit > Replace. The Replace screen appears.

b.Enter *DRIVE* in the Find what field and enter the drive letter in the Replace with field.

c.Click Replace All.

c. Log in to SQL*Plus on the database server as the user sys.

From a Windows or Unix command prompt, complete the following steps.

a.Enter sqlplus sys/<password> as sysdba, where <password> is the user sys 
password

b.Press Enter.

c.Enter @ORACLE110.sql and press Enter.

Step 10 - Initialization Parameters 1. Click the Character Set tab and 
select the Choose from the list of 
character sets option. Select 
WE8ISO8859P1 - ISO 8859-1 
West European from the drop-
down list.

2. Click the All Initializations 
Parameters button. The All 
Initializations Parameters screen 
appears. 

3. Click Show Advanced 
Parameters. Scroll to db_files and 
change the value from 200 to 600. 
Scroll to db_securefile and change 
the value from PERMITTED to 
ALWAYS.

Step 13 - Database Storage Modify the path for Oracle datafiles, 
control files, redo logs, and archive logs 
to reflect your system.

On this screen... Do this...
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SQL*Plus reports whether each tablespace was created successfully.
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Install the Oracle Client

You must install the Oracle Database 11g Release 2 Client for Microsoft Windows (32-bit) on your 
Practice Partner server and each client workstation on which you want to run Practice Partner. You 
also must install the Oracle Database Client on any interface computer (server or workstation). 
See your Oracle documentation for instructions.

Oracle Client Configuration
After you install the Oracle 11g Release 2 Client software on each client workstation on which you 
want to run Practice Partner, make sure you have the correct Oracle character set in the system 
registry and that your Oracle home environment variable is pointing to your preferred Oracle client. 
See your Oracle documentation for Oracle installation instructions, and complete the steps below 
to make sure the following configurations are set for your Oracle 11g R2 client.

After you verify the configurations below, you can install the Practice Partner client. See “Client 
Workstation Installation” on page 31 for step-by-step instructions. The Practice Partner client 
installation automatically sets up the Oracle client connection. A new entry in the tnsnames.ora file 
will appear after the installation.

To confirm you have the correct Oracle character set in the system registry:
1. Select Start > Search. 

2. Enter regedit and click Search.

3. Double-click the regedit.exe file. The Registry Editor appears.

4. Refer to the following table to complete this step.

5. Make sure that the NLS_LANG entry is AMERICAN_AMERICA.WE8ISO8859P1. If you need 
to update the entry, complete the following steps.

a. Right-click the NLS_LANG entry and select Modify. The Edit String screen appears.

b. In the Value data field, replace the existing entry with 
AMERICAN_AMERICA.WE8ISO8859P1.

6. On your client machine, make sure that your Oracle home environment variable is pointing to 
your preferred Oracle client.

a. Select Start, right-click My Computer, and click Properties. The System Properties 
screen appears.

If you have a... Then select...

32-bit machine HKEY_LOCAL_MACHINE > 
SOFTWARE > ORACLE > 
ORACLE_HOME entry (the exact entry 
is different for each site).

64-bit machine HKEY_LOCAL_MACHINE > 
SOFTWARE > Wow6432Node > 
ORACLE > ORACLE_HOME entry (the 
exact entry is different for each site).
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b. On the Advanced tab, click Environment Variables. The Environment Variables screen 
appears.

c. In the System Variables list, scroll to Path entry. Make sure the path entry points to your 
preferred Oracle client’s path.
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Appendix C - Installing and Administering a c-
tree Server for Practice Partner

The following table indicates whether this appendix applies to your situation.

This appendix describes how to install and administer c-tree Server for Practice Partner.

The primary advantage to switching to c-tree Server is reliability. Instead of every Practice Partner 
user opening and writing to a data file, each file is opened only once by the c-tree Server process. 
The Practice Partner clients communicate with c-tree Server, which then writes the data to the files.

You must install c-tree Server and run the FairCom Server Activation Utility before installing 
Practice Partner. 

What database are you using? Appendix to use to create your 
database:

Microsoft SQL Server “Creating a Microsoft SQL Server 
Database for Practice Partner” on page 45.

Oracle “Creating an Oracle Database for Practice 
Partner” on page 53.

c-tree This appendix.
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Installing c-tree Server for Practice Partner

To install c-tree Server for Practice Partner:
1. On the c-tree Servers explorer screen, click the Install c-tree Servers link.

2. Click the Install button next to Windows NT/2000/XP (Intel).

Figure 29.  Windows Systems screen

3. Select setup.exe. The Welcome to c-tree Server V7 for Windows Setup screen appears.

4. Click Next. The FairCom Server Licensing Agreement Reminder screen appears.

5. Click Yes. The Choose Destination Location screen appears.



Installation Guide
March 2019 Release 11.2 63

Appendix C - Installing and Administering a c-tree Server for Practice Partner Installing c-tree Server for Practice Partner

6. Accept the default destination folder or specify the drive and path for the server files. You can 
use the Browse button to navigate to the folder. Click Next. The FairCom Server Configuration 
screen appears.

Figure 30.  FairCom Server Configuration screen

7. In the Server Name field, enter a name for the server. If you are unsure what name to enter, 
leave the default FAIRCOMS. You can always change the name later by editing the server 
configuration file (ctsrvr.cfg).

8. Select the Standard option and click Next.

9. When the server files are installed, click Finish.
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Running the FairCom Server Activation Utility

You must run the FairCom Server Activation Utility prior to installing Practice Partner. Complete the 
steps below to run the utility.

To run the FairCom Server Activation Utility:
1. Double-click fcactvat.exe, located at C:\Faircom\v7.12\c-treeServers\c-treeServer. The 

FairCom Server Activation Utility screen appears.

Figure 31.  FairCom Server Activation Utility screen

2. Enter the serial number and activation key provided by Practice Partner.

When you enter the serial number, do not enter the leading 88. For example, if your serial 
number is 88123456, enter 123456.

3. Click Activate.

4. Click OK to confirm that you have activated the server.
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You will not receive a License disk. Instead, you must download the product license from the eMDs 
Practice Support website. New license files are required for each new version of Practice Partner.

To download your license files:
1. Go to the eMDs Practice Support website at https://practicesupport.emds.com.

2. Enter your eMDs Practice Support website username and password. 

3. Click the Login button.

4. Under Quick Links on the left side of the eMDs Practice Support website, click the 
Downloads & License Files link.

Figure 32.  eMDs Practice Support website - Quick Links

The Product Downloads and License Files page appears.

Figure 33.  Product Downloads and License Files page

5. To download the current (11.0) license file, click the drop-down arrow on the Download 
Current Version button and select Download License File from the menu.

https://practicesupport.emds.com
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To download the previous (9.5.2) license file, click the drop-down arrow on the Download 
Current Version button and select Download Previous License from the menu.

Figure 34.  Product Downloads and License Files page

The license file will be downloaded immediately to your machine.
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Installing your License Files for Practice Partner

Read the following instructions carefully. 

Download your license files before you begin your installation of Practice Partner.

To install Practice Partner:
1. Create a License folder on the drive that the ppart folder is on (typically, the P:\ drive).

a. Go to Start > All Programs > Accessories > Windows Explorer.

b. Browse to the drive that the ppart folder is on.

c. Create a new folder by right-clicking a blank area in a folder window or on the desktop, 
pointing to New, and then clicking Folder.

d. Rename the default folder to License and press Enter.

2. Save the files attached to the e-mail to the License folder (usually P:\License). One of the files 
is named pplic.txt. If this file doesn’t exist (some e-mail programs remove this file), save the 
other file in the License folder and rename it to pplic.txt.

3. Begin your installation of Practice Partner. During the installation, you will be prompted to 
browse to the License folder where your license files are located.

To change the number of licensed users:
Prerequisites: You must know the path to your Practice Partner data files directory (typically 
p:\ppart) and all users must exit all Practice Partner applications.

1. Create a License folder on the drive that the ppart folder is on (typically, the P:\ drive).

a. Go to Start > All Programs > Accessories > Windows Explorer.

b. Browse to the drive that the ppart folder is on.

c. Create a new folder by right-clicking a blank area in a folder window or on the desktop, 
pointing to New, and then clicking Folder.

d. Rename the default folder to License and press Enter.

2. Save the files attached to the e-mail to the License folder (usually P:\License). One of the files 
is named pplic.txt. If this file doesn’t exist (some e-mail programs remove this file), save the 
other file in the License folder and rename it to pplic.txt.

a. Go to Start > Run.

b. Enter the path to your Practice Partner data file directory followed by \SETUSER2. For 
example, if your data is located in p:\license, enter:

p:\ppart\setuser2 p:\license

If you are... Then refer to...

installing or upgrading Practice Partner to a 
new version

“To install Practice Partner:” on page 67.

changing the number of licensed users of 
Practice Partner

“To change the number of licensed users:” on 
page 67.
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3. Click OK.
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You can configure Practice Partner to automatically generate unique demographic identification 
numbers. This means that each time you add a new account, guarantor, or patient, Practice 
Partner automatically assigns a unique ID based on the settings you have selected.

To set up demographic ID settings and turn on the auto ID feature:
1. Open the ppart.ini file (typically located in p:\ppart).

2. In the [DemographicIDs] section, indicate

 - the number of characters for each ID (the ID’s length).

 - the increment between each unique ID.

 - whether each ID should have a prefix (for example, enter A for account IDs, G for 
guarantor IDs, P for patient IDs, and M for message IDs).

3. Open a command prompt.

a. Click Start > Run.

b. In the Open field, enter cmd and click OK.

4. The following table describes what to enter at the command prompt.

To turn on the automatic 
demographic IDs feature for...

Then enter...

account IDs p:\ppart\plugnxid auto A and press Enter.

guarantor IDs p:\ppart\plugnxid auto G and press Enter.

patient IDs p:\ppart\plugnxid auto P and press Enter.

message IDs p:\ppart\plugnxid auto M and press Enter.
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Appendix F - Header Repair Utility

This appendix applies to you ONLY if you use a c-tree Server database.

The Header Repair utility fixes c-tree files that need to be reset when the c-tree Server process 
ends unexpectedly (as in the server does not close properly). C-tree Server files must be set to a 
certain value for the files to be opened. These files will not reopen if the c-tree Server process 
closes unexpectedly. This utility rewrites the header of the files that need to be reset with the 
header of another file. You may reopen the server once all files that need to be fixed have been 
reset by the utility.

To use the Header Repair utility:
1. Open Windows Explorer and browse to the ppart directory.

2. Double-click fixhdr.bat.

You also can start the utility by opening a DOS prompt and navigating to the drive where the 
ppart directory is located. Enter fixhdr.bat and press Enter.

The Header Repair utility starts.

While the utility runs, you may see the error message error open : call=043 in the DOS 
prompt. This message displays when the utility is trying to correct a .pht file. This message 
does not affect the utility’s performance and can be ignored.

3. When the utility completes, restart the database.

4. Restart c-tree Server.
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Appendix G - Practice Partner Supplemental 
Functionality

The following tables list the product name, the product name as seen under the Product column on 
the eMDs Practice Support website, and the name of the downloaded installer files.
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Patient Records, Appointment Scheduler, and Medical Billing Appendix G - Practice Partner Supplemental Functionality

Patient Records, Appointment Scheduler, and 
Medical Billing

The PRWIN, MBWIN, and ASWIN products all are the same software. You need to download only 
one of these from the eMDs Practice Support website. The appropriate options are installed based 
on the contents of your license file. There is no content download specific to the Order Entry 
product. If your organization is licensed for Order Entry, it is included as part of the Patient Records 
installation.

Practice Partner Product 
Name

Product Name Installer Name (Server/
Client)

Patient Records PRWIN Server: setup.exe

Client: setup.exe

Medical Billing MBWIN Server: setup.exe

Client: setup.exe

Appointment Scheduler ASWIN Server: setup.exe

Client: setup.exe
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Appendix G - Practice Partner Supplemental Functionality Practice Partner Add-on Products

Practice Partner Add-on Products

Add-on Product Name Add-on Product Name Add-on Installer Name

AMA Code Updater CPT-ICD9 AMA Code Updater 
v11.0.7571.msi

Brentwood EKG module EKG Brentwood EKG 
v11.0.7571.msi

Brentwood Spirometry 
module

SPIRO Brentwood Spiro 
v11.0.7571.msi

Clinical Tools ClinicalTools Clinical Tools - Drug 
Interaction.msi

setup.exe

Clinical Tools - Templates 
v11.0.7571.msi

Instant Medical History IMH TextLoadScheduler.exe

Patient Education PATEDU-5 Patient Education 
v11.0.7571.msi

Practice Partner Zoom Zoom PPZoom v11.0.7571.msi

Updox Updox Refer to the Updox chapter in 
the Practice Partner Add-ons 
Configuration and Installation 
Guide.

XFire - Demographics 
Interface

XFire - Maintenance Interface

XFire - Demographics

XFire - Maintenance

XFire - Demographics 
v11.0.7571.exe

XFire - Maintenance 
v11.0.7571.exe
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Practice Partner Interfaces Appendix G - Practice Partner Supplemental Functionality

Practice Partner Interfaces

Interface Product Name Interface Product Name Interface Installer Name

PerSe Billing Bridge PPC-PerSeBillingBridge PerSe Billing Bridge 
v11.0.7571.msi

PPConnect PPConnect PPConnect v11.0.7571.exe

PPConnect - Billing Bridge PPC-Billing Bridge Billing Bridge v11.0.7571.msi

PPConnect - GE EKG PPC-GEEKG GE EKG v11.0.7571.msi

PPConnect - Immunization 
Registry

PPC-Immunization ImmunizationRegistry 
v11.0.7571.msi

PPConnect - LabCorp PPC-LabCorp LabCorp v11.0.7571.msi

PPConnect - LabCorp Billing 
Bridge

PPC-LabCorpBridge LabCorp Bridge 
v11.0.7571.msi

PPConnect - Paragon PPC-Paragon Paragon v11.0.7571.msi

PPConnect - RelayHealth PPC-RelayHealth RelayHealth v11.0.7571.msi

QuestToro Billing Bridge PPC-QuestToro Quest Toro Billing Bridge 
v11.0.7571.msi
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Appendix G - Practice Partner Supplemental Functionality Practice Partner Templates

Practice Partner Templates

Template Collection Name Name Extraction File Name

Practice Partner Cardiology 
Specialty Template Collection

Templates-Cardio Templates-Cardio07-09.exe

Practice Partner Chiropractic 
Template Collection

Templates-CHIRO Templates-CHIRO03-10.exe

Practice Partner Dermatology 
Specialty Template Collection

Templates-Derm Templates-Derm05-09.exe

Practice Partner 
Endocrinology Specialty 
Template Collection

Templates-Endo Templates-Endo05-09.exe

Practice Partner 
Gastroenterology Specialty 
Template Collection

Templates-Gastro Templates-Gastro12-08.exe

Practice Partner Neurosurgery 
Specialty Template Collection

Templates-NS Templates-NS01-09.exe

Practice Partner GYN 
Specialty Template Collection

Templates-OBGYN Templates-OBGYN02-09.exe

Practice Partner Orthopaedics 
Specialty Template Collection

Templates-Ortho Templates-Ortho02-09.exe

Practice Partner Podiatry 
Specialty Template Collection

Templates-Podiatry Templates-Podiatry08-10.exe

Practice Partner Urology 
Specialty Template Collection

Templates-Urology Templates-Urology02-09.exe
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Practice Partner Templates Appendix G - Practice Partner Supplemental Functionality

If your organization is registered to receive the Practice Partner Templates, they will display in your 
list of registered products on the Product Downloads and License Files page. 

After you have downloaded and extracted your registered Template Sets, refer to the 
corresponding Practice Partner Template documentation for more information.

To download and extract your templates from the eMDs Practice Support website:
1. Click the appropriate template link on the Product Downloads and License Files page. The 

Product Information page appears.

2. Click the Download Updates link. The Download Update for page appears.

3. Under the Current Version section, click the template link. The File Download - Security 
Warning dialog box appears.

4. Click the Save button.

5. Choose a download location on your hard disk and click the Save button. The download 
process begins. When the process is complete, the Download Complete dialog box appears.

6. Do one of the following:

 - Click the Run button. 

or 

a. Click the Open Folder button to open the folder where the system saved the download.

b. Double-click the .exe file. 

The WinZip Self-Extractor dialog box appears.

7. Choose a location on your hard disk and click the Unzip button.

8. The system extracts the files to the selected location. If the files extracted successfully, a 
confirmation message appears. Click the OK button.

9. Repeat the steps above to download all of your template products from the eMDs Practice 
Support website.

Are you a new site? Then you must download the templates...

yes when you download the rest of your Practice 
Partner software.

no only when there is an update to a template.
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Appendix H - Troubleshooting

This appendix offers solutions to some common issues.

Microsoft .NET Framework
In most cases, the Practice Partner installer will automatically detect if you have the Microsoft .NET 
Framework 4.0 framework pre-installed; if the framework is not installed, the installer will install it 
for you automatically. However, if an error occurs when the installer attempts to install the Microsoft 
software, the following message may appear:

An error occurred while installing system components for Practice Partner Server. Setup 
cannot continue until all system components have been successfully installed.

If this message appears, you must manually install Microsoft .NET Framework 4.0 before 
proceeding with the installation. You can download Microsoft .NET Framework 4.0 from the 
Microsoft Download website.

NOTE: If you are using Microsoft Windows 2008 R2, you can add Microsoft .NET Framework 4.0 
as a feature.

Microsoft Script Runtime was not found
If you receive the Microsoft Script Runtime was not found error after installing Practice Partner, 
complete the following steps.

PP_DB_APP error message (Oracle sites only)
If your site uses Oracle, the Practice Partner installation generates a password. If the generated 
password begins with a number, an error similar to the following appears:

PP_DB_APP user cannot be created due to its password.

If you receive this message, cancel the installation and restart the installer.

Reinstalling the EMR
Reinstalling the EMR for Practice Partner Server may result in the services not starting. If this 
happens, obtain a backup copy of the interop.datapassageLib.dll, drop it into ppart, and then try 
restarting the services. If you already have rolled back before you attempt another install, have that 
file ready to drop in as soon as the ppart files are being populated during the install.

If your site uses a... Complete these steps...

64-bit machine 1. Open a command prompt.

2. Enter C:\windows\syswow64\regsvr32.exe 
C:\windows\system32\scrrun.dll and press Enter.

32-bit machine 1. Open a command prompt.

2. Enter C:\windows\system32\regsvr32.exe 
C:\windows\system32\scrrun.dll and press Enter.
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